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Welcome to CryptoEdit
Encrypted RTF Documents with Images
CryptoEdit is a program to create and edit protected encrypted documents.
It can manage TEXT, RTF and RTFD (with images) format.
It saves documents on disk always as encrypted and is the ideal solution to manage
reserved documents with formatted text and images.
CryptoEdit is absolutely simple, powerful and secure.

CryptoEdit allows to edit document as a normal simple word processor which can
handle text and images. All the feature available in a modern Cocoa based rich text
processor are available in CryptoEdit.
The text can be formatted using rules, different font,style, size and colour.
All the usual manipulations of fonts are available via menu and dialogs plus custom
styles are available. Spelling in your native language. Text search is full
implemented.
Insertion of images inside the document with just drag and drop.
CryptoEdit can import from other documents in standard TEXT or RTF or RTFD
(RTF + images) .
Documents can also be exported as TEXT, RTF or standard RTFD (included
images)
CryptoEdit document are saved always encrypted for security purpose. If you saved
it you can be sure that you saved it encrypted.
Saving a document containing images, will create on disk a single le with all the
text and images encrypted in a single le. Any data the user puts in the document is
encrypted and not readable without the right password.
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Getting Started with CryptoEdit
Start to Work with CryptoEdit
At launch CryptoEdit opens automatically e “Untitled” empty window.
It will ask for a password to protect the document.
Any CryptoEdit document is always encrypted and protected.

Insert the password you want to use to protect the document then start edit it.

You can use CryptoEdit exactly as a normal styled editor.
All the function available in a advanced editor are available under CryptoEdit.
You can even drag and drop images from the nder inside a document and them will
be embedded inside
You can create complex document with images and formatted text inside using
different font, size and colors.

Document will be saved on disk as usually but always encrypted and protected.
The protection of the document it is Not based on a trick.
The protection it is not based on the application refusing to open the document if
you don't insert the password.
The protection is based on the encryption, using the new AES-256 algorithm, of the
entire content of the document.
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When you open a document, if you don't provide the right password, the entire
content of the le is an unrecognizable bunch of bits and no one, even expert
hackers or programmers, can understand them.
There is also an important thing: if you loose the password of a document, it can't be
opened.
Even we, the developer of CryptoEdit can't help you.
There are no backdoors or others trick. CryptoEdit is a security tool and we realized
it as the best tool we could produce with honesty and integrity. We ensure the users
that there is no way to break it except breaking the AES-256 encryption of the data
inside the document.
We will repeat it again: there are no backdoors of any sort in Crypto Edit.
To decrypt the le content, you must have the password used to protect it.

To avoid to forget the passwords used to protects your documents, we suggest to
save the passwords used inside Password Repository, a software we produce
useful to manage all your passwords of any kind.
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CryptoEdit Reference
About CryptoEdit
CryptoEdit is an advanced TEXT, RTF and RTFD (with Images) Editor based on
Cocoa, able also to embed images in text, that saves documents on disk always in
a encrypted (password protected) way
The user has no way to save the document in plain format, this to avoid to save
reserved data in a form anyone can read by mistake. If it was saved with CryptoEdit
is secure by default.
Only a person knowing the password used to save a CryptoEdit document, will be
able to open and read it.
CryptoEdit is easy to use because it is similar to other word processor available on
the Mac plus adding default encryption on anything saved on disk.
CryptoEdit uses the strong AES-256 encryption algorithm to encrypt and decrypt
data on the y without any appreciable delay in opening and saving documents.

Features
The features of CryptoEdit in editing document are:
Full text justi cation with use of rules with available different ruler format for any row.
Full use of fonts, styles, colors, and even of custom styles as in a full featured word
processor and full use of the standard Font Dialog.
Full range of Find functions usable in the document.
Spelling service.
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Inclusion of images in many format, tiff, jpg, gif ... and so on, using a simple Drag
and Drop and with a resulting le, when saved on disk, totally encrypted included
the embedded images in a single le. This is different of a standard RTFD le which
saves the le as a bundle, with images embedded inside the bundle. This is what we
think is the perfect solution, considering CryptoEdit is about safety of your data, and
we assume that also the images inside your reserved documents are reserved too.

Open and save
CryptoEdit is a document based standard Mac application.
You can manage as many documents you like in the usual Mac way.
Autosave is enabled by default.

Public Note
You can have a CryptoEdit document display a public note opening it, before
inserting the password. This is intend as a way to have a text note available to
everyone, also people without the password to open the document. The public note
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is "public", everyone can read it just launching the document, so, do not insert
reserved data in the public note!
The Public note can be inserted while editing the document.

The public note is not encrypted. Typically you can insert a text for you to read
before inserting the password, or if you want to distribute your document, you can
use the public note to explain how to obtain the password from you ... and so on.
Use the public note inside the document for the purpose you need.
Access this functionality from the menu or the standard toolbar.
When the document will be re-opened, the user will see the public note while he is
requested to enter the password to unlock the document.
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Toolbar
You can use the toolbar at the top of the CryptoEdit Window to access frequented
function.
With control-click (or right-click if you have a 2/3/n buttons mouse) you can also
select "Customize Toolbar" and specify the icon buttons inside it in the usual
standard way.
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Read/Write
You can specify from the toolbar or the menu a le as read only, in that case you will
not be able to edit it
With another click the status of the document can be changed back
A document saves its status over application relaunches

Import from File
To import data inside a CryptoEdit document, select the a import command from the
“File” menu.

The content of the imported document will be placed at the insertion point.
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Export to File
To export the data inside a CryptoEdit document select one of the export command
under the File menu.
CryptoEdit will present a standard le dialog: specify the le to export to, and
CryptoEdit will export all the content of the document to the le in the format you
selected.
The resulting exported le will be readable by any standard application able to red
the exported format, text, rtf or rtfd (rtf + images)
The CryptoEdit document is not affected in any way, you only just exported in a plain
le a content of a secure document, so this can in some way make available to
everyone accessing the exported le, a private content. You know the content of the
le, you exported it, you know if this is want you really want ... at this point you
should understand what you do with your data.

Changing the password
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If you select text inside your document the imported content will replace the selected
text. In same way it works as the paste command.
Import can work importing Text or RTF les or RTFD les.
The "Import as Text from File" works on text and also on RTF and RTFD les.
Everything imported will be considered a text le.
If you import a RTF le with with "Import as Text from File"
you will insert the rtf code as if it was text.
If you want to import a RTF le and have the RTF feature enabled as in a true RTF
editor, you must use the "Import as RTF from File…"
Using "Import as RTF from File…" allows only to select les ending in .rtf and insert
the content directly with the RTF formatting applied.
You can also import RTFD les. RTFD les are a special kind of RTF with images
embedded.
RTFD les are implemented as bundle with RTF and images of different format
resulting in a single graphical page. You can import only from les ending in .rtfd
When you import a RTFD le, CryptoEdit handle it natively and place the content as
usually at the current prompt position. The result of the imported area is a formatted
text and graphics as the one imported. The difference is only at saving time.
When you save a CryptoEdit le, it is saved on disk in a single encrypted le, even if
it contains images, and not in a bundle (RTF + images) as in a RTFD les.
Well, we can say that you can work with CryptoEdit and you don't need to know that
to use it. It is just to understand the difference on a RTFD standard le and a
CryptoEdit le containing content imported from a RTFD le. In a plain RTFD le the
images are separate from the text and placed inside the same bundle (which looks
like a single doc on Mac), in CryptoEdit rtf text and images are all encrypted and
stored in a single data le, all encrypted.
When you import data or embed images also using drag and drop, data will be
encrypted by CryptoEdit saving the document, but what is encrypted is the
CryptoEdit document with the data that were copied from the source to the
document. The original data still are on your Hard Disk in plain format and they can
be read by everyone. If you delete the source, the imported data still are inside the
CryptoEdit document, images included, because, we will repeat it, they were copied
inside the document, images included.
If you don't delete the source you have the data encrypted in the CryptoEdit
document but the original source still are on your Hard Disk in plain format.

You can at any time change the password de ned to protect the document.
Do it using the “Password” command from the “File” menu or from the toolbar. To
change it you must provide the old password and insert and con rm the new one.

If you change the password and you have written down the password in a secure
place (as an example on a paper or using CryptoEdit) , remember to update it, or
when you will go to read it you will read the old one, and when you will try to open
the document with the old password you have changed ... you understand, also
smart people sometime do silly things.
Note that the password is case sensitive, so “myhome” and “Myhome” are different
password

Please check that the caps lock of your keyboard is not inserted when you digit the
password (unless you really want it) because if you think you have inserted
“myhome” and you inserted “MYHOME” as long as you will try to open the
document with “myhome” you will get a wrong password alert that can drive you
crazy. We reported this speci c case because we noticed that is a common error by
users. We also noticed at that point that people try to insert the same wrong
password a zillion of time hoping the computer will accept it. We can insure you that
if it is wrong, CryptoEdit won't accept it, even if you try a zillion of time.
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Encryption
Encryption is a fundamental part of CryptoEdit.
With computers now part of our current life, everyone has reserved data on her/his
Mac.
These data contains detail very very important about personal life or work.
A person simply can't afford that someone can read and maybe make public these
data.
Your computer can be stolen, especially if it is a portable, and at that point it is just a
matter of hours before all your data will be scanned.
You may also need technical assistance, because your computer need to be xed
by a technician, and you have to give it to a technical center, and you can be sure
someone will have access to all the plain data on your hard Disk.
If you have used CryptoEdit and you have used a good password others can do
nothing with your data, because they are encrypted with a strong algorithm
(AES-256) and without the password your data are a useless series of bit, just crap.
I can't say it is impossible to decrypt them, but the effort necessary to break
AES-256 in the way CryptoEdit uses it, it is really too much for them.
CryptoEdit doesn't allow to save without password, if you saved it, you can be sure
that you saved it encrypted. You won't nd yourself asking " Did I save it encrypted?"
It's a feature!
CryptoEdit asks you to use a password of a minimum of 6 character to force you to
use a password with a minimum of security. This because 6 char is the minimum
length for a good password. Longer (at least 9 chars or more) is better.
It would be possible also to let the software choose the password for you the rst
time, but you need a password you can remember, so you need to think yourself at
the password to use.
Unfortunately very often this is a cause of big pain because people doing this don't
realise they are disabling the scope of encryption, using a week password. Please
use a good one (one other can nd easily)
Crypto Edit can decrypt previous document created with the old version (1.x)
of CryptoEdit using the Blow sh algorithm, successive saving operations will
convert the document to use the new AES-256 based format

Dark Appearance Mode
This application is fully compatible with Dark Appearance Mode available on macOS
from macOS 10.14 Mojave and obviously with Light Appearance Mode on any
macOS release it can run on.

Preferences
General
Specify the action to do at startup
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Edit
Settings used opening a new document:
• Ruler in the document visible
• Check Spelling as-you-type enabled
• Font used in a new opened document
• Font used to display the public note
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Advanced
Advanced settings:

The Auto Lock time after which a document auto lock itself if the application was put
in background (very useful to don’t forgot Crypto Edit with reserved data opened if
we switch to another application)
All the opened documents will be auto-locked.

Update

CryptoEdit can inform you if an update is available.
We suggest to leave this option on.
When you check if an update is available, the application ping the Tension Software
server and receive an answer about the last release available, the application can in
that way know if its obsolete or not.
In case the application will ask you if you like to download an upgrade.
The Update section is not available in the App Store Release (if you purchased
via the App Store, to obtain an update use the App Store Update function)
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If you download the upgrade from our site, also using the upgrade function internal
to the app, you need to install it.
A common error is to download an upgrade and install it maintaining the old
application somewhere on the hard disk.
Then using to open the documents sometime the old application and sometime the
new one. This cause some problems*. To avoid it simply install your application in
the place dedicated to it, the Application folder. When you install an update on the
standard Application folder, the system will ask if you want to replace the old one
with the new, answering yes will install the new one replacing the old.
*If the application says the document you are trying to open was created with a newer
version of the application, probably you have two different release of the application on your
Hard Disk and you are trying to open a document with the older version after having
modi ed the document with the new one. When you receive a similar message open the
about box inside the application and see if you are running the last release. In case
download it, install it and USE it!

Only upgrade from the App Store are installed automatically.

Using CryptoEdit as a service from other applications
To use CryptoEdit as a service you need rst to enable the service it offers in the
central place Apple reserved to enable it.
Open your General preferences dialog and select
Keyboard > Shortcuts
Search for ‘New CryptoEdit Document with Selection’ and select it
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At that point from any application you can create in a single command a CryptoEdit
document containing a text selection.
In any application supporting Text:
Select the text and use from the ‘Application Menu’
Service > New CryptoEdit Document with Selection
CryptoEdit will launch creating a document containing the selected text
It will ask to insert a new password to protect the document.

Help
CryptoEdit provides a standard PDF User guide included with the application.
You can access it under the Help menu.

Support
You can also obtain support using the ‘Support Email...’ command. An email will be
prepared using your email client with the correct address to send to.
Yes, we answer to your emails.
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CryptoEdit is a Commercial Program
If you downloaded it form our site you can use our software for a test period of 10
days
After that you are required to buy a license to be legally authorised to continue to
use our software
In case of the App Store release, a license is already included with your App
Store purchase and you don’t need to buy a license

Licensing CryptoEdit

You can buy a license to use our software using the ‘Buy License’ command under
the Help menu.
You will open in your browser our license web page on our web site
In case of the App Store release, a license is already included with your App
Store purchase and you don’t need to buy a license

About Tension Software and Ecleti
All the software asset by Tension Software is now under Ecleti
New company name but still the same owner and main developer (Roberto Panetta)
So for the users nothing changes. We provide the same software and the services.
All the user licenses are valid and assistance is provided as before to all our users.
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